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Every Child magazine: 

Contributor guidelines 

Target audience 

Every Child is a magazine for all people who 

educate and care for young children, and those 

who are interested in current developments in 

topics related to early childhood such as 

education and care, research, public policy, 

professional learning, child learning, 

development, wellbeing, health and safety, 

advocacy and ethics, and professional 

partnerships with families, carers and 

professionals. 

Every Child does not publish articles that have 

been published elsewhere, and articles it does 

publish may not be published elsewhere 

(without express permission). All authors—

commissioned or otherwise—are required to 

sign a copyright licensing agreement to this 

effect, in exchange for a payment. More 

information below. 

Word count 

Articles can either be long (800–1000 words) or 

short (300–500 words). Book reviews are 

typically 150–200 words. Manuscripts over the 

word limit will be returned. Please aim to write 

under the limit to allow for editing changes. 

Submission guidelines 

All articles that are deemed suitable for 

publication will go through a process of 

review and re-submission until final content 

is approved. There is no guarantee of 

publication at any stage. 

Authors will be sent the final edited draft of 

their article, as ECA proposes to publish it in 

Every Child. In order to do so, ECA requires the 

author to sign a copyright license agreement in 

exchange for payment, to the effect that they will 

not republish the article elsewhere (without 

express permission) and will not reproduce it 

except for use in their own ‘classes or lectures’. 

ECA reserves the right to decide if and when to 

publish all drafts submitted for Every Child. 

Commissioned articles 

Authors commissioned to write for Every Child will 

work to an agreed topic based on their expertise. 

They will work with the Every Child Editors and 

Publishing Editor on an agreed approach to the 

article outline and content. 

The Publishing Editor will provide submission 

dates for initial drafts, and due dates for revisions 

requested following review of their draft by the 

Every Child Editors and/or Publishing Editor. It is 

the author’s responsibility to inform the 

Publishing Editor as soon as possible if they 

cannot meet the agreed due dates. 

Drafts received significantly after the final due date, 

without prior arrangement with the Publishing 

Editor, may be rejected or published in a later 

edition. Authors will be kept up to date with their 

work’s progress. 

Unsolicited articles 

Unsolicited drafts can be submitted by email 

to publishing@earlychildhood.org.au, but 

please read the below before submitting. 

Unsolicited submissions are initially subject to 

basic editorial review by the Publishing 

Editor to ensure they meet a minimum 

quality standard, followed by content review 

by the Every Child Editors. 

Those considered unsuitable for the magazine 

will not be given detailed feedback. 

Unsolicited articles that are approved for 

publication will be shortlisted and Every Child will 

ECA Author Guidelines 
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endeavour to publish them all within 12 to 18 

months, but this is not guaranteed. 

Writing guidelines 

Prospective contributors are advised to read 

recent copies of the magazine if possible. Some 

free online Every Child articles, typically one per 

edition, are available online here: 

https://www.earlychildhoodaustralia.org.au/our

-publications/every-child-magazine/every-child-

index/ 

Please ensure your draft: 

 serves the readers of Every Child and the 

wider community as its primary purpose; 

i.e. it is not advertorial, content 

marketing or any other commercial 

device 

 uses an expository writing style 

 is written in easily readable plain English 

and does not use unexplained jargon 

 has an interesting, short title 

 is structured logically and includes 

concise headings and subheadings 

 is accessible to readers from a wide 

variety of backgrounds and assumes 

minimal existing knowledge 

 targets people working with or caring for 

children aged from birth to eight years 

 acknowledges all types of early childhood 

services, where appropriate 

 is honest and ethical, i.e. it uses genuine 

examples, true stories and accurate 

quotes from real people 

 does not describe or represent specific 

people without their consent—including 

children 

 is culturally sensitive and uses inclusive 

language 

 does not use long block quotations, from 

academic sources or elsewhere 

 has minimal references (no more than 10) 

 only makes claims of fact that are verifiable 

and/or attributed to their source(s). 

Manuscripts will be edited to conform to ECA’s 

in-house style and register. Edits may be 

substantial or minor, depending on the quality 

of the manuscript. It is advised that authors read 

recent copies of the series to familiarise 

themselves with the expected writing style. 

Edited versions will not be published without the 

author’s written consent. 

ECA style requirements 
The current Australian Government Style Manual 

(https://www.stylemanual.gov.au/) is the basis 

for ECA’s house style. Its use allows for uniformity 

of spellings, punctuation, formatting, etc. in all 

our publications. Some instances may require 

divergence, but they are treated on an individual 

basis. Macquarie Dictionary is the accepted 

dictionary of ECA publications. Authors must 

follow these reference works. 

Readability  

Language  

ECA expects the authors to write their 

manuscripts in a way that makes the concept and 

language accessible to different reading levels. 

The Flesch reading-ease score of your 

manuscript must be no lower than 40. Revisions 

will be required if the reading-ease score is 

outside this range. Take the following steps to 

check the reading-ease score of your manuscript 

within MS Word: 

 Windows 

o Go to File > Options. 

o Select Proofing. Under When correcting 

spelling and grammar in Word, make sure 

the Check grammar with spelling check 

box is selected. 

o Select Show readability statistics. 

https://www.earlychildhoodaustralia.org.au/our-publications/every-child-magazine/every-child-index/
https://www.earlychildhoodaustralia.org.au/our-publications/every-child-magazine/every-child-index/
https://www.earlychildhoodaustralia.org.au/our-publications/every-child-magazine/every-child-index/
http://www.umich.edu/~exppro/info.html#what
https://www.stylemanual.gov.au/
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o After you enable this feature, open a file 

that you want to check, and check the 

spelling by pressing F7 or going to 

Review > Spelling & Grammar. When 

Word finishes checking the spelling and 

grammar, it displays information about 

the reading level of the document. 

 MacOS 

o On the Word menu, click Preferences 

(you must have a document open to see 

preferences). 

o Under Authoring and Proofing Tools, 

click Spelling and Grammar. Under 

Grammar, select the Check grammar 

with spelling check box. 

o Select the Show readability statistics 

check box, and close the Spelling & 

Grammar dialog box. 

o On the Tools menu, point to Spelling and 

Grammar and click Spelling & Grammar 

(after Word finishes checking spelling and 

grammar, it displays information about 

the reading level of the document). 

Note: Regardless of the operating system, you 

must correct or ignore all errors before the 

readability statistics will display. 

You may also use external readability tools to 

assess the reading level of your document: 

https://readable.com/  

Terminology 

ECA prefers to use non-stereotyped language 

and situations in its publications, i.e. authors 

should avoid the use of sexist, ageist or racist 

terminology. For example, use ‘firefighter’ 

rather than ‘fireman’. In describing work in the 

early childhood sector, use general terms to 

ensure broad application, e.g. ‘parents and 

carers’, ‘settings’, ‘practitioners’, ‘early 

childhood educators’ (not ‘teacher’, unless 

specifically applicable), ‘the adult working with 

the children’, ‘early childhood professionals’, 

‘early childhood service’. For more 

information, consult ECA’s free publication, 

‘How to talk about early childhood education and 

care’ 

(http://www.earlychildhoodaustralia.org.au/wp-

content/uploads/2021/07/How-to-talk-about-

ECEC.pdf).  

Numbers and figures 
The use of metric measurement is the accepted 

form of measurement in ECA publications. Words 

should be used when expressing numbers from 

zero to nine, inclusive. (This form may have to be 

varied to make a particular mathematical point, 

e.g. where the item being described is normally 

represented arithmetically: 4 + 2 + 12 children = 

our group of 18 children.) 

Figures rather than words should be used in the 

following examples: 

Sum of money: $5.08 or 25c, $2,000, $10,000  

Time of day: 10.30 am, 50 minutes, eleven 

o’clock  

Date: 14 September 1994 (day, month, year)  

Mass: 250 t, 120 kg, 50 g 

Measure: 56 litres, 25 mL, 26 km, 25 cm, 16 

mm 

Inclination: (degrees): angle of 45 degrees or 

45° 

Temperature: 35°C 

Percentage: 9% (numeral followed by percentage 

sign is the preferred style of expression in text) 

Age: 60 years old, an eight-year-old, five- to 

six-year-old children  

 

The use of metric measurement is the accepted 

form of measurement in ECA publications. 

Formatting 
Manuscripts should have minimal formatting and 

indication should be clearly given for the 

placement of tables, graphs and charts. It is best 

to explain any notes or suggestions for design and 

layout using square brackets, e.g. [text box] / [text 

box ends], [insert photo xxx.jpg here]. If it is 

https://readable.com/
http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
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necessary to include a table, use the table 

function of your software. Use of dot points is 

encouraged where possible, to break up the 

text. Please mark headings, subheadings and 

paragraphs clearly. For example: 

Heading level 1  
(Bold, size 16, only the first letter is 

capitalised) 

 

Heading Level 2 
(Bold, size 14, only the first letter is 

capitalised) 

 

Heading Level 3 

(Bold, italic, size 12, only the first letter is 

capitalised) 

 

Heading Level 4 

(Italic, size 11, only the first letter is 

capitalised) 

 

Use plain text in your document—the only 

formatting permitted is discussed in the points 

below: 

 Only use one space after full stops, 

commas, colons and semicolons. 

 Only use one line space between 

paragraphs. 

 Only use single spacing between words 

in the text. 

 Only use italics to indicate emphasis or 

names of publications. 

 Use single ‘smart quotes’. 

 Normal template (text) is Calibri 11 pt, 

6 pt before and after, multiple 1.15 

spacing, margins normal (2.54 cm all 

around). 

 To indicate emphasis, use italics only 

and do so sparingly, as with all forms of 

emphasis. 

It is very important to conform to these 

guidelines. Manuscripts that do not follow 

these guidelines will be returned to authors 

and may miss publication deadlines. 

References 
APA 7th style referencing is used in Every Child; 

please see https://apastyle.apa.org/. 

If you are quoting directly from a specific source 

or relying on a piece of information, theory or 

claim/s of fact it contains, please include an 

author-date citation in the text following the 

APA style, 7th edition. If a direct quote is cited, 

add the page number. 

In the body of the text, reference should be 

made only to the author/s and the year of 

publication (Johnson & Johnson, 1992), or 

Johnson and Johnson (1992) (direct quote: 

(Johnson & Johnson, 1992, p. 139) or Johnson 

and Johnson (1992, p. 139)).  

For referencing, Every Child articles use APA 7 

author-date citations, not footnotes. 

■ Avoid quotes longer than 50 words for Every Child. 

Every Child is not an academic text, so please 

keep references to a minimum (five to 10 

references).  

Please list all references and resources at the end 

of the manuscript in the following formats: 

From a book 

Dorn, L. R., & Ryrerson, D. (1984). Elements of a 

healthy childhood (2nd ed.). Macmillan. 

From a journal 

Scott, I. (1992). Home injury to children. 

Australian Journal of Early Childhood, 17(3), 18–

24. 

From the internet 

Center on the Developing Child. (2018). Brain 

architecture.  Harvard University. 

https://developingchild.harvard.edu/science/key-

concepts/brain-architecture. 

Acronyms 
When using an acronym or initialism, the first 

occurrence must be spelt in full with the 

https://apastyle.apa.org/
https://developingchild.harvard.edu/science/key-concepts/brain-architecture
https://developingchild.harvard.edu/science/key-concepts/brain-architecture
http://theage.com.au/news/agenews/phstole.html
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acronym/initialism quoted in parentheses, e.g. 

Early Childhood Australia (ECA). Subsequent 

occurrences should use the initialism. 

Photographs/illustrations 
If photographs/illustrations are supplied by 

ECA, ownership and copyright will be retained 

by ECA. 

We encourage authors to supply their own 

illustrations and photographs. Authors are 

responsible for ensuring that ECA receives a 

Photograph Permission Form signed by the 

parents of children appearing in any supplied 

photographs, as well as approval from the 

photographer to use the photo, before 

publication.  

Permission forms can be obtained from the 

Publications and Production team. Required 

format is minimum 300 dpi resolution in tiff or 

jpeg file format. Email images separately—do 

not embed them into the manuscript. ECA 

retains the right to omit the use of author-

supplied photographs if they do not meet the 

required printing standards noted above. 

Form of submission 
Please email the commissioned manuscript to 

the publishing editor. Unsolicited manuscripts 

can be emailed to 

publishing@earlychildhood.org.au. 

Manuscripts should include page numbering 

and a running header. Microsoft Word (doc) is 

the preferred format. If using other formats, 

please specify the software used, or contact 

the Publications and Production team before 

submission. 

Publication process 
All manuscripts are subject to review by the 

Editors and Publishing Editor. Manuscripts 

being considered for publication will often 

undergo numerous drafts before being 

accepted. Authors will have every opportunity 

to make changes up to the design and layout 

stage.  

Final authority for approval of changes rests with 

the Every Child editors. 

All authors will receive a maximum payment of 

$250 (exc. GST) for long articles or $100 (exc. 

GST) for short articles after publication and one 

(1) complimentary copy of the magazine in

which their article appears at the time of

distribution.

Assignment of copyright—Author 

license agreement forms 
Author license agreement forms will be sent to 

authors along with the copyedited version of 

their article for approval. These must be signed, 

completed and returned to the publishing editor 

before publication. 

Further enquiries 
Please contact the ECA Publications and 

Production team at the earliest possible stage if 

you have any queries about ECA processes 

regarding the publication of your manuscript. 

Contact details 
Every Child Magazine 

Early Childhood Australia 

Publications and Production 

Address: PO Box 86, Deakin West, ACT 2600 

Tel: (02) 6242 1800  

Email: publishing@earlychildhood.org.au  

Website: www.earlychildhoodaustralia.org.au 

mailto:publishing@earlychildhood.org.au
mailto:publishing@earlychildhood.org.au
http://www.earlychildhoodaustralia.org.au/



